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Preparing Images for Upload (Web-ready) 
 
All images need to be edited and saved for the web (smaller files allow quicker loading) before being 
uploaded. It is best to prepare all images before uploading.  
 
1. Open the image in Photoshop. 
 
2. Resize the image to ensure fast and efficient loading times (Very Important): 
 
Body images: Under the Image Menu, choose Image Size and enter the width or height. Width should 
be a maximum of 400 px wide for horizontal images and 400 px high for vertical. Make sure the little 
chain icon on the left of Width and Height is clicked to keep the image proportional.  
 

 
 
Thumbnail images: Thumbnail images, which appear at the top of the article, have dimensions of exactly 
230 px by 170 px. In Photoshop, select the crop tool, choose W x H x Resolution from the drop down 
menu, then enter 230 px x 170 px in the options bar, as seen here: 
 
 

 
 
Note:  Ignore Image Size: at the top as this is what the image size would be uncompressed. 
 
3. Save in appropriate web format (Usually JPEG) 
 
Choose Save for Web under the File Menu and save the image in JPEG format if it is a photo (GIF if it a 
line drawing or cartoon). For JPEG, select High which will automatically change Quality to 60%. Leave 
everything else as the default. 
 
Choose Save and save the photos in a convenient spot that is easy to find when you upload – this could 
be a folder on your desktop that you can delete later. Use a descriptive name (not the file numbers) and 
do not have spaces or periods (except for right before the extension eg: .jpg) within the name. Dashes and 
underscores are okay eg: election_results.jpg.) 
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You will not be able to upload images that are over 100KB 
 

Submitting Articles 
 

Login 
 
Go to www.calgaryjournal.ca/administrator and login with the following: 
 
Your username is your cjournal.ca email address: YourfirstinitialLastname@cjournal.ca 
 
Your password is the last 6 digits of your student ID number. 
 

Submitting and Formatting Text 
 
Once logged in, go to the Content menu at the top, then Article Manager, then click the green ‘New’ 
button on the top left. 
 

 
 
If you are editing an existing story, you can sort the list of articles by the most recent first by clicking on 
‘date’ two times: 

 
 
You can also narrow down the articles by various criteria by clicking on ‘Search’ to reveal various options 
for sorting. 
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If you see a lock icon to the left of the title:  hover over the lock to see who last accessed the article, 
and if you are sure this author is no longer on the article, double click on the lock to unlock the article. 

Step 1: Inserting headline and body text 
 
Enter the headline in the Title field. 
 
Copy the full text of the article from the Word Doc as plain text. To paste as plain text, right click and go 
to ‘paste as plain text.’ A new window will appear – paste it into the window and click ‘insert.’ 
 
Pasting as plain text ensures the text is clean, with no extra formatting tags. Usually, the paragraph will be 
broken up correctly, but some fixing may be needed. Scroll through the text to make sure the paragraphs 
are proper.  
 
If paragraph breaks need to be inserted, make sure to place the cursor just behind the period of the last 
sentence of the paragraph above, press delete or backspace to bring the sentence below to the same line, 
then enter or return. This will insert just one paragraph break. 
 
If there is a deck, highlight it and choose ‘Heading 3’ from the format 
dropdown menu. If there are sub-headings in the article, highlight them 
and choose ‘Heading 4.’  
 
Note: Adding the byline is a separate step, described in Step 9 below. 

Step 2: Intro Text 
 
Click on Read More to separate the intro text from the rest of the article – insert this after 10 to 15 lines of 
text (including the deck).  
 
The Read More icon is in the top menu, fourth line, to the right of spell check: 
 

 
 
Anything above this separation will appear as an intro on the main page, then clicking Read More will 
display the whole article.  
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Step 3: Inserting Links 
 
Highlight the words you want hyperlinked (a 
live link to the URL), then click this icon within 
the tool bar:  

  
 
Enter the full URL, including the 'http://' - it is 
best to copy and paste to avoid typos. Text will 
be the words you highlighted. 
 
Under Attributes, choose Open in New 
Window from the Target Menu, leave the rest 
'as is' and click Insert. 
 
For internal articles within the Calgary Journal 
website, you can also search or navigate to the 
content under ‘browse.’ 
 
Note: There is no need to Open in New 
Window if you are linking to an internal article, 
this is just for external links. 
 
 

 

Step 4: Inserting body images and cutline 
 
All articles need at least one body image, but there may be more.  
 
Click on the Insert/Edit Image icon within the toolbar. 
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Then click the “upload” icon, above and to the right of the ‘details’ panel.  
 

 
 
A new window will appear:   
 

 
 
Click Browse, navigate to the web-ready image, highlight it, click Open, then click Upload.  
The box will close and the image will appear within the list to the left of the Details panel, in bold - click on 
it and it will refresh itself and a URL will appear in Properties above: 
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Set the following Properties: 
 
URL: No need to enter anything here – the URL should have appeared when you clicked on the image 
name by the Details panel. If not, click it again.  
 
Alternative text: Insert a very short description of the image. For example, 'giraffe'. You do not need to 
enter the full cutline description here - this text will show up for people with visual impairments who use 
screen readers. 
 
Dimensions: Leave as is - the image should have already been re-sized in Photoshop to ensure the best 
quality. 
 
Alignment: Choose Right if you want the image to float to the right side of the main text; choose Left for 
the left side.  
 
Clear: Leave as is. 
 
Margin: Leave as is – default 5px margin is set. 
 
Border: Leave as is – default is no border 
 
Once you have set the image properties, click Insert (bottom right) and the image should appear within 
the text.  
 
To edit the image, click on it, then click on the Insert/Edit Image icon again – this will allow you to change 
the properties if you need to. (EG. you may decide to align to the right instead of the left.) 
 
Add a cutline 
 
Highlight (click on) the image and click on the Add/Edit Caption icon (to the right of Add/Edit Image). 
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The following window will appear: 
 

 
 
Copy and paste the cutline and photo credit into the ‘Text’ field, leave all the 
rest as is and then click ‘Insert.’ 
 
The image, cutline and credit should all appear within a red box. 
 
Cutline Format: Bold the cutline; Italicize the photo credit  
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Step 5: Add the thumbnail 
 
All stories must have a thumbnail image within the intro text for each article: 

 
The thumbnail image should be placed below the deck. Create a space for the thumbnail by putting 
curser at the end of the deck and pressing return (enter). Insert the image as described for the body 
images above. Align it to the left by clicking on the image, then choose ‘floatleft’ from the Styles 
dropdown menu.  
 
If the thumbnail is a smaller version or portion of one of the body images that are already in the article, 
there is no need to provide a photo credit. If the thumbnail does not appear within the body of the article, 
place a photo credit at the bottom of the article (more info below in ‘Final Steps.’) 
 

Step 6: Creating a pull quote (optional) 
Choose the text/quote you want to have as a pull quote and copy it to where you want it to appear in the 
article as a new paragraph. Highlight the text, go to the ‘styles’ drop down menu and chose 
pullquote_right or pullquote_left. This will create a box that floats to the right or left of the rest of the 
body, in italics in a light grey box . 
 
Include attribution, first and last name in front of a dash. The style will automatically be italicized, as seen 
below 
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Step 7: Inserting a Side Bar or Table (optional) 

A side bar is a table with one column and one row. Click on the Table Icon in the top menu:  
 
Enter the following properties then click ‘insert’: 
 

 
 
Cols: 1, Rows: 1, Cellpadding 5, Cellspacing: 5, Alignment: Left or right, Width: 50%. Leave the rest 
as is. 
Paste the side bar text into the table. Be sure to Paste as Plain text.  
 
 
Add a background and border by placing the curser in the table, right click and go scroll to ‘Cell’ > ‘Table 
Cell Properties.’ Click on the Advanced tab and enter the following properties then click ‘update’: 
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Border color: #000000 (black), Background color: #cccccc (grey) 
 

Step 8: Related Articles 
 
The option to choose some related articles is found to the right of the body field. You can add 3 to 5 
related articles by searching for a keyword and choosing the article 
 
Example of related Articles for a story about a DJ: 
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The related articles will appear within the body of the article automatically. 
 

Step 9: Status, Category & Byline 
 
By default, the Status, found on the right under ‘Related Articles’ will be ‘Published.’ This can be changed 
to ‘Unpublished ‘for articles that are not ready to appear on the live site yet. 
 
Choose the appropriate Category from the category drop down and leave the rest ‘as is’.  
 
To enter the byline, click on the ‘Publishing’ Tab at the top: 
 

 
Enter the reporters name in Created by Alias.  

 
Note: the style will automatically be capitalized on the live version 
 
Changing ‘Featured’ to yes will make the article appear on the Frontpage, but this decision should be 
determined as a group. Leave it as no at this point. 

Step 10: Preview and Linking Thumbnail 
 
- Click the blue preview button at the top, in the middle: 
 

  
 
 - A new window will open with a preview of what the article will look like live. Make a note of any issues 
that need fixing (spacing, alignment, etc).  
- Hover over the title, right click and go to ‘Copy Link Address’ then close the preview window 
 

 
 
- Click on the thumbnail, the click on the chain icon and paste the URL 
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Step 11: Final Steps 
 
1. Scroll through and read the article, check for spacing issues, alignment of pictures, and typos.  
NOTE: If you need to Copy/Cut/Paste, please use the keyboard short cuts: 
 
command + c = copy 
command + x = cut 
command + v = paste 

Sometimes you will need to look at the HTML code to fix formatting issues. Click this icon:  
 
See HTML Fixes tips sheet here: www.calgaryjournal.ca/pdf/html.pdf  
 
 
2. Extras at the end of the article: Insert the author’s cjournal email at the bottom of the article, non-
italicized, and information/email of the editors, italicized, as seen here: 
 
klmartin@cjournal.ca 
 
The editor responsible for this article is (editor’s name) and can be contacted at (editor’s email) 
 
3. Add Icons to indicate if there is video, audio, photo gallery or a question. 
 
For video, audio, photo gallery, highlight the deck, go to the styles menu and choose the appropriate style: 
h3.videoicon; h3.audioicon; h3.pictureicon. eg: 
 

 
 
Important Note: make sure the deck is a Heading 3 or this will not work. 
 
For a question at the bottom of article, go to the styles menu and choose: question. eg: 
 

 
 
4. Photo Credits: Ensure the photo credit for all photos appears beside the bolded cutline in italics, as 
described on pg. 9. Thumbnail images need to be credited if they are not taken by the same 
photographer as the images within the body of the article. This credit can be added to the bottom of the 
article – non-italicized - after the editor information (described above in #2). EG: 
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Thumbnail courtesy of (Photographer’s name). 
 
Images used from creative commons libraries need to have the photographer’s name linked to their body 
of work, and the Creative Commons information linked to the specific license. EG: 
 
Photo courtesy of www.bluewaikiki.com/Flickr, Creative Commons Licensed 
  
 
 
5. You can do a spell check by clicking on the following icon: 

 
Errors will appear with red, wavy underline (like in MS Word.) 
 
6. Click the Preview button again to ensure the article still looks good with these final additions. 
 
7. Then, click Save & Close at the top. View the ‘live’ article to ensure it looks good. 
 

Important notes 
 

- The ‘undo’ function - command + z or go to the browser menu edit > undo – can be very 
useful. If this does not work the first time, make sure you click within the body of the article and try 
it again. 

- Ten versions of previous iterations of the article will be tracked. To go to a former version, click the 
version button at the top, put a check by the version you want to restore, and select ‘restore.’ 
 

 

Section Editor Duties 
Front Page Articles 
There should be four articles feature on the front page. To feature an article, click on the star to the left of 
the title. Featured articles will have a yellow star. Click on Featured Articles on the left to show just the 
featured articles. 
 
Creating Duplicates of an Article (saving the article in another Category) 
 
There will often be the need to have a same article in more than one Category. To create a duplicate, click 
into the story you want duplicated and at the top click on ‘Save as Copy’ button. This will add (2) to the 
end of the headline - delete this.  Then choose the new category from the drop down menu and click 
‘Save and Close’. Then check to make sure the new article is published. 
 
 
Creating features for Individual Sections 
Each section will have three articles featured/highlighted at the top. The section editor for the section is 
responsible for choosing the featured items for each issue.  
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1. Choose and record the Articles ID’s for the three 

articles you want to highlight. Navigate to the 
article on the live site and write down the 
number that follows the section in the URL. For 
example, in this URL the Article ID is 962:  
http://calgaryjournal.ca/index.php/news/962-
nobody-will-listen-says-members-of-mental-
health-group 

2. Go to Extensions > Module Manager, then 
enter your section by ‘filter’ to find the ‘feature 
stories’ module. EG: for News, the module is 
called ‘Feature News Stories’ 

3. Click on the module, scroll down and click on 
the yellow arrow beside Source Setting, ensure 
‘Source From’ is set to Joomla Article IDs, and 
enter the three IDs you chose separated by 
commas, as seen on the right. 

 
Embedding a Photo Gallery into an article 
 
Once a gallery has been created, it will appear in the ‘The Lens’ section on the main menu, but it can also 
be embedded directly into an associated article. In order to complete this step, make sure the visual 
editors have first created the gallery. 
 
Place the gallery at the bottom of the article, just above the email address of the author. Place the curser 
here then click on the Gallery icon (below the body of the article on the left): 
  

 
 
Leave Type as Single Gallery Images, choose the gallery you want to appear from the Category Drop-
down menu, Change the profile to The Lens – Insert Content, then click Save and Close. 
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A snippet of code such as: {igallery 
id=91|cid=165|pid=4|type=category|children=0|addlinks=0|tags=|limit=0} 
will appear in the back end, but the gallery should show up in this spot when the article 
is live. Double check to ensure it works on the live view. 
 

Creating a poll  
 
Editors can create simple polls on various topics and display them in the sidebar for specific sections, on 
all sections, or on the front page. 
 
Detailed instructions are here: 
 
http://www.calgaryjournal.ca/guide/polls.pdf 
 

Linking an image to a PDF 
 
You may sometimes have an info-graphic that will not be readable as an image. In this case you can 
create a screen capture of a portion of the PDF, insert it as an image, and link the image to the PDF. 
 
Go to Media Manager, scroll down to the bottom and browse to the PDF then click ‘upload’. Make a note 
of the exact file name – you will need this to link the image after. 
 
Take a screen shot of a portion of the PDF and in Photoshop, resize it to be no bigger than 300 px wide. 
In the article, upload the image, float to the left or right, highlight it and link it to the PDF. This URL will be 
images/nameoffile.pdf. EG. images/SuperBowl.pdf.  
 
Add a caption to the image to describe the Info-graphic. EG Super Bowl Predictions – link this to the 
PDF as well to make it more obvious to the reader that there is more information.  
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Reviewing and approving comments 
 
When a comment is posted, an email will go to your editor and chef and Kerri. The editor and chef will 
forward to the section editor to approve and respond to if necessary. To approve, login to the backend 
administrator panel, click on Components, then RS Comments. Click on ‘comments’ to see a list of 
comments, and click under publish to publish.  

 

Web Style Guide 
 
Headline: Will appear in red at the top – make sure to follow CP Style: First word in caps, the rest in 
lowercase unless it is a proper name/title. 
 
Deck: Heading 3 
Subheads: Heading 4 
 
Body text: Be sure to ‘paste as plain text’ and separate paragraphs – no other formatting is required. 
 
Created by Alias: This will appear as ‘written by’ at the top of the article: 
 

 
Readmore: Content before read more should include: Short Deck (10 to 15 words or two lines), thumbnail 
image and first paragraph or sentences (10 to 15 lines including deck). 
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Thumbnails: Every story that is uploaded needs a thumbnail. If you do not have a thumbnail, think about 
'art' as thumbnail. If you have no thumbnail at all, talk to your photo editor. Thumbnails images that do not 
appear in the body of the article in a larger format may need to have a short cutline/photo credit applied. 
 
Cutlines: Cutline bold, credit italics.  
 
Photo credit styles: 
 
Photos taken by Calgary Journal reporters should read: Photo by Jonathon Choe  
Photos taken by non Calgary Journal reporters should read: Photo courtesy of Sandra Smithson 
Photo illustrations should reference original works: Illustration by Jonathon Choe; Source material 
courtesy of Sandra Smithson  
 
If you copy and paste the credit and it is in caps, instead of re-typing, highlight it and choose ‘lowercase’ 
from the styles menu. 
 
CJ Emails: After every story, place the reporter's cjournal email at the bottom. Tell your reporters to check 
their emails in case they get feedback. 
 
Dates: When making reference to dates, avoid using days of the week. Opt for specific dates or take out 
the reference to the date all together. 
 

Other Guides 
 
Visual Editors User Guide  
HTML User Guide 
Audio/Video User Guide 
CJournal Email Guide 
Editor Group Emails 


